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Overview 

Stellar Phoenix Database Repair for MySQL is designed to repair data from damaged or corrupt MySQL 

database. Using strong algorithm, the software does a complete scan of the corrupt MySQL database and 

efficiently repairs almost every bit of information without deleting or modifying original data. Even heavily 

damaged database can be optimally repaired and restored with this software. 

 

Stellar Phoenix Database Repair for MySQL gives two options to select damaged or corrupt MySQL 

database- automatic and manual.  

In automatic selection option, the software automatically selects database(s) from the default installation 

location of MySQL if MySQL is installed with default configuration. 

In manual selection option, user can select database(s) from different locations. User can browse to locate 

the desired database(s). However, user should provide a root folder that contains at least one database 

and ibdata file for corresponding database. User can search ibdata file from different location, however, it 

should correspond to the selected database. If corresponding ibdata file is unavailable for a database then 

it cannot be repaired. 

 

After scanning, Stellar Phoenix Database Repair for MySQL provides preview of database in a tree 

structure. User can view the components of selected database and can repair desired components. 

 

The software also shows details of ongoing process in a Message log pane. These details can be saved 

in a text file. 

Key features: 

 New and enhanced GUI. 

 Find option to search items of database in the tree generated after scanning process in preview 

window.  

 Repairs database created using database storage engines of MySQL-MyISAM & Innodb. 

 Repairs MySQL database installed on Linux platform. 

 Repairs primary key(s), relations and tables. 

 Shows preview of Properties of tables. 

 Repairs Properties of tables. 

 Shows preview of queries of Views and Triggers. 

 Repairs MySQL objects such as Views and Triggers in the form of query. 



 

 

 Repairs all data types except spatial data types. 

 Repairs data on which default and auto-increment properties are applied. 

 Supports MySQL 6.x, 5.x, 4.x, and 3.x (You need upper version of MySQL to repair 3.x files). 

 Options to customize software. 

 Support for new format of Date data type in MYSQL 5.6 and above. 

 Support for new format of Datetime data type in MYSQL 5.6 and above. 

 Support for new format of Timestamp data type in MYSQL 5.6 and above. 

 Support for new format of Time data type in MYSQL 5.6 and above. 

  



Installation Procedure 

Before beginning installation, make sure that the computer meets minimum system requirements. 

 

Minimum System Requirements  

 Processor: Pentium Class 

 Operating System: Windows 10 / 8.1 / 8 / 7 / Vista / XP  

 Memory: Minimum 1GB (2 GB Recommended)  

 Hard Disk: 100 MB of free space  

 MySQL Version:6.x / 5.x / 4.x / 3.x 

To install the software, follow the steps given below:  

1. Double-click StellarPhoenixDatabaseRepairforMySQL.exe. A setup dialog box is displayed.   

2. Click Next to continue. License Agreement dialog box is displayed.   

3. Select I accept the Agreement option. Click Next to continue.   

4. Specify location where installation files are to be stored. Click Next to continue.  

5. Select the folder where files are to be stored. A default folder is suggested in Select Start Menu 

Folder box. Click on Browse to select a different location. Click Next. 

6. In Select Additional Tasks dialog box, choose check box as per your choice. Click Next.   

7. Review entries. Click Back if you want to make any changes. Click Install to start installation. The 

Installing screen shows the installation process. 

8. After completion of installation process, Completing the Stellar Phoenix Database Repair for 

MySQL Setup Wizard screen opens. Click Finish. 

 

You can clear Launch Stellar Phoenix Database Repair for MySQL Setup check box to stop 

automatic launch of the software. 

 



 

 

Launching the Software 

To launch Stellar Phoenix Database Repair for MySQL, 

To launch Stellar Phoenix Database Repair for MySQL in Windows 10: 

 Click Start icon -> All apps -> Stellar Phoenix Database Repair for MySQL -> Stellar Phoenix 

Database Repair for MySQL. Or, 

 Double click Stellar Phoenix Database Repair for MySQL icon on the desktop. Or, 

 Click Stellar Phoenix Database Repair for MySQL tile on the home screen. 

To launch Stellar Phoenix Database Repair for MySQL in Windows 8.1 / 8: 

 Click Stellar Phoenix Database Repair for MySQL tile on the home screen. Or, 

 Double click Stellar Phoenix Database Repair for MySQL icon on the desktop. 

To launch Stellar Phoenix Database Repair for MySQL in Windows 7 / XP: 

 Click Start -> Programs -> Stellar Phoenix Database Repair for MySQL -> Stellar Phoenix 

Database Repair for MySQL. Or, 

 Double click Stellar Phoenix Database Repair for MySQL icon on the desktop. Or, 

 Click Stellar Phoenix Database Repair for MySQL icon in Quick Launch. 

  



Ordering the Software 

The software can be purchased by making payments online. Once the purchase order is confirmed, a 

prepaid serial number is sent to the buyer through e-mail. The product can be activated using this serial 

number. To purchase the software, follow any of these methods:  

 

1. To purchase the software online, please visit https://www.stellarinfo.com/database-recovery/mysql-

recovery/buy-now.php for more information and to place an order. 

2. If demo version is installed, click Purchase button in Help menu on menu ribbon on the main user 

interface to go through purchasing process. 

3. When you try to repair corrupted database in demo version of the software, you get a message that 

you need to purchase the product in order to save repaired database. Click OK to purchase the 

software. 

  

https://www.stellarinfo.com/database-recovery/mysql-recovery/buy-now.php
https://www.stellarinfo.com/database-recovery/mysql-recovery/buy-now.php


 

 

Registering the Software 

The demo version is just for evaluation purpose and must be eventually registered to use the full 

functionality of the software. The software can be registered using the Registration Key which you will 

receive via email after purchasing the software.  

To register the software: 

1. Run demo version of Stellar Phoenix Database Repair for MySQL software. 

2. On Tools menu, click Register option. Register window is displayed as shown below. 

 

3. Choose ’I don’t have the registration key’ (Use this option if you have not purchased the product) 

or select ’I have the registration key’ (Use this option if you have already purchased the product). 

To register the software, when you do not have a registration key, follow the steps 

given below: 

1. In the Register window, select 'I don't have the registration key' option. Click OK, to go online 

and purchase the product. 

2. Once the order is confirmed, a Registration Key will be sent to the email provided at the time of 

purchase.  

3. In the Online Registration window, type the Registration Key and click Register button (Please 

ensure that you have an active Internet connection). 



 

4. ‘Activation Completed Successfully ' message is displayed after the process is completed 

successfully. Click OK.  

To register the software, when you have a key, follow the steps given below: 

1. In the Register window, select 'I have the registration key' option. 

2. You can choose either 'Online Registration' (Use this option to register the software over Internet) 

or 'Offline Registration' (Use this option to register the software manually / through e-mail if for any 

reason, Internet connection is unavailable). 

 Online Registration 

Online Registration is possible only when an active Internet connection is available. 

o To register the software online: 

1. From the Register window, select Online Registration. Click OK.  

 

2. An Online Registration dialog box will appear. 

3. Type the Registration Key (received through email after purchasing the product) in the 

field of Registration Key. Click Register. 



 

 

 

4. The software would automatically communicate with the license server to verify the entered 

key. If the key you entered is valid, software will be registered successfully. 

 Offline Registration 

Offline Registration enables you to register the product when your computer does not have an 

Internet connection. 

o To register the software offline: 

1. From the Register window, select Offline Registration. Click OK.  

 

2. An Offline Registration dialog box will appear displaying Registration ID in its respective 

field. 

 



3. To get your License Key, which is required to register the software manually, you need to 

mail the listed Registration ID to support@stellarinfo.com. 

4. A License Key will be sent to your email address after verifying the Registration ID and 

purchase details by Stellar Technical Support. 

5. After receiving the License Key, open Stellar Phoenix Database Repair for MySQL. In 

Register window, select 'I have the registration key'. 

6. Select Offline Registration and click OK. 

7. Enter the License Key received through email in the field of License Key.  

 

8. Click Register to activate the software. A confirmation message is displayed if a valid key is 

entered. Click OK. 

  



 

 

Transfer License 

Stellar Phoenix Database Repair for MySQL allows you to transfer the license of the registered software 

to another computer on which you want to run the software with full functionality. This operation deactivates 

the product on your current computer so it can be reactivated on the new computer.  

To transfer a software license from one computer to another, please follow the 

specific steps below: 

On Target Computer:  

1. Run demo version of the software. 

2. In Tools Menu on Menu Bar, click Register. A new dialog appears. 

3. From the Register window, select Offline Registration. Click OK.   

4. An Offline Registration dialog box will appear displaying Registration ID in its respective field. 

 

On Source Computer: 

1. Run registered version of Stellar Phoenix Database Repair for MySQL software. 

2. In Tools Menu on Menu Bar, click Transfer License. 

 

3. Copy the Registration ID displayed on the Target Computer in the field of Registration ID on the 

Source Computer. 



4. To get your License Key, click Transfer In button on Source Computer. This will generate a License 

Key. 

5. You can also save the License Key generated on the source computer. Click Save to File button 
to save the Registration ID and the License Key. In Browse for Folder dialog box, select the 
location where you want to save the details. Click OK. 

6. 'License Key has been saved successfully' message is displayed after the saving process is 
completed successfully. Click OK. 

 

This will deactivate the product on Source Computer and you will no longer be able to use the software 
anymore on this computer. 

On Target Computer: 

1. Type the License Key which you have generated on the Source Computer in the provided field of 

License Key. 

 

2. Click Register to complete the activation process.  

3. 'Activation Completed Successfully' message is displayed after the process is completed 
successfully. Click OK. 

  



 

 

Updating the Software 

There are periodical software updates for Stellar Phoenix Database Repair for MySQL. Software updates 

should be done to keep the software up-to-date. Updates can be a newly added functionality, a new feature, 

a new service or any other information that can be important for improvement. Update option in the 

application is capable of checking for the latest updates. This will check for both latest minor and major 

version available online. You can easily download minor version through the update wizard. However, the 

major version, if available, has to be purchased. While updating the software, it is recommended to close 

all the running programs. Note that demo version cannot be updated.  

 

To update the application, follow these steps: 

 Click on Update button in Tools menu on the main user interface. Stellar Phoenix Update Wizard 

is displayed. 

 Click Next. A busy timer shows that updates are being searched. If it finds any new version, a 

message indicates the availability.  

 If a message is displayed that no updates are available, click Cancel to close the wizard. 

 Click Next. The software will start downloading update files from the server. When the process is 

complete, the software will upgrade to the latest version. 

  



Stellar Support 

Our Technical Support professionals will give solutions for all your queries related to Stellar products.  

You can either call us or go online to our support section at http://www.stellarinfo.com/support/ 

For price details and to place the order, click https://www.stellarinfo.com/database-recovery/mysql-

recovery/buy-now.php 

Chat Live with an Online technician at http://www.stellarinfo.com/ 

Search in our extensive Knowledge Base at http://www.stellarinfo.com/support/kb/ 

Submit enquiry at http://www.stellarinfo.com/support/enquiry.php 

E-mail to Stellar Support at support@stellarinfo.com 

Support Helpline 

Monday to Friday [24 Hrs. a day] 

USA (Tollfree- Pre Sales Queries)USA 
(Post Sales Queries) 

UK (Europe) 
Australia & Asia Pacific 

Netherlands Pre & Post-Sales Support 
Worldwide 

Email Orders  

+1-877-778-6087 
+1-732-584-2700 
+44-203-026-5337 
+61-280-149-899 
+31-208-111-188 
+91-124-432-6777 
orders@stellarinfo.com 

  

http://www.stellarinfo.com/support/
https://www.stellarinfo.com/database-recovery/mysql-recovery/buy-now.php
https://www.stellarinfo.com/database-recovery/mysql-recovery/buy-now.php
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/kb/
http://www.stellarinfo.com/support/enquiry.php
mailto:support@stellarinfo.com.
mailto:orders@stellarinfo.com


 

 

How to Uninstall the Software? 

Stellar Phoenix Database Repair for MySQL can be removed either using Uninstall Stellar Phoenix 

Database Repair for MySQL program in the software or from Add/Remove programs in Control Panel. 

 

To uninstall the application using Uninstall Stellar Phoenix Database Repair for MySQL:   

Click Start -> All Programs -> Stellar Phoenix Database Repair for MySQL -> Uninstall Stellar 

Phoenix Database Repair for MySQL. Follow on screen instructions to completely remove the 

software, including registry entries from your computer.  

 

To uninstall the application using Control Panel: 

Click Start -> Control Panel -> Add Or remove Program. Select Stellar Phoenix Database Repair 

for MySQL entry from the displayed list and click Change/Remove. Follow on screen instructions 

to completely remove the software as well as registry entries from your computer. 

  



User interface 

Stellar Phoenix Database Repair for MySQL has a simple and user-friendly interface that lets you access 

its various feature with ease.  

 

After launching the program, you will see the interface as shown below: 

 

 

 

The main user interface consists of Quick Access Toolbar, Menubar, Panes, and Status bar. 

 

  



 

 

Quick Access Toolbar 

The Quick Access Toolbar of Stellar Phoenix Database Repair for MySQL is a customizable toolbar 

where you can add commands for quick access. 

 

Quick Access Toolbar has a dropdown menu 

with following options: 

Select: Select this option to add this command 

to Quick Access Toolbar. 

Repair: Select this option to add this command 

to Quick Access Toolbar. 

More Commands: Use this option to add/remove commands and customize keyboard shortcuts. 

Show Below the Ribbon: Use this command to put Quick Access Toolbar below the menu ribbon. 

Minimize the Ribbon: Use this command to minimize the menu ribbon. 

  



Menu Ribbon 

File                                                                                                    

Select: Click this button to select corrupted/damaged 

MySQL database for repair. 

Repair: Click this button to repair corrupted/damaged 

MySQL database. This button is enabled after you 

have scanned database. 

Stop: Click this button to stop repair process. This button is enabled after you have started repairing 

process. 

Exit: Click this button to close the application. 

Status Bar: Check this check box to view status bar at the bottom of application window. 

Message Log: Check this check box to view message log pane that contains details of ongoing process. 

 

Tools 

Save Log: Click this button to save log details in a 

text file. 

Clear Log: Click this button to erase log details from 

message log pane. 

Register: Click this button to register the software after purchasing. 

Transfer License: Click this button to transfer the license of the registered software to another 

computer. 

Update: Click this button to download updates for the application. 



 

 

Help 

Purchase: Click this button to go through process of purchasing the software. 

Submit an Enquiry: Click this button to submit 

enquiry to stellarinfo.com. 

Knowledgebase: Click this button to visit 

knowledgebase articles of stellarinfo.com. 

Help: Click this button to view Stellar Phoenix Database Repair for MySQL help manual. 

About: Click this button to read information about Stellar Phoenix Database Repair for MySQL. 

 

Search Tree Item:  

You can search for specific items of database in the tree 

generated after scanning process in preview window.  

To search for specific item, type the name of desired item 

in Find Items search text box and click Find button. Continue clicking Find button to find more items with 

the same text as entered in search text box. 

  



Panes 

By default, the application window contains three panes: - Left pane, right pane, and bottom pane. 

Left pane displays database and its components in a tree structure generated after scanning of database. 

 

 

 

Right pane displays details of components selected in the tree in left pane. 

 



 

 

 

 

Bottom pane displays details of the ongoing processes. These details can be saved as a text file for later 

reference.  

 

 

 

  



Database Repair - Prerequisites 

There are certain prerequisites for database repair. Before starting repairing process, ensure that  

 

 MySQL is installed on the system on which the repairing process needs to be performed.  

 MySQL is installed with default configuration and ibdata file is stored at the same location as 

MySQL database if you wish to select database automatically.  

 ibdata file for corresponding database is available if you wish to select database manually.  

 Free space same as the size of selected database is available on the drive on which database is 

stored.  

  



 

 

Select Database 

In order to recover data from a corrupt/damaged MySQL database, you need to select the corrupt/damaged 

database. Stellar Phoenix Database Repair for MySQL gives you two options to select database: 

 

 Select database Automatically 

 Select database Manually 

To select database automatically: 

Launch Stellar Phoenix Database Repair for MySQL. Along with the main user interface, Select 

Database(s) Location window opens as shown here: 

 

 

 

You can also open Select Database(s) Location window by clicking Select button in File menu on 

the main user interface. 

By default, Repair corrupt database(s) stored at default location of MySQL option is selected. If not, 

select the same. 

Click OK. 

The list of all database(s), which are stored in the same location as MySQL, is shown as given below: 



 

 

 

Select checkbox(s) of database(s) that needs to be recovered. All database(s) can be selected at once by 

clicking Select All button. To deselect all database(s) simultaneously, click Unselect All button. 

Click OK.  

The software starts scanning of database(s). 

To select database manually: 

Launch Stellar Phoenix Database Repair for MySQL. Along with the main user interface, Select 

Database(s) Location window opens. 

 



 

 

 

 

Select Manual selection of database(s) to repair option. Browse button will be enabled. 

Click Browse. Browse for Folder dialog box opens. Select the folder that contains database(s). Click OK.  

The list of all database(s) stored in the selected folder is displayed as shown here: 

 

 

 



 

The software starts scanning of database(s). 

 

If ibdata file for corresponding database(s) is not available in the same folder, then Stellar Phoenix 

Database Repair for MySQL dialog box opens prompting user to provide path of ibdata file.  

 

  



 

 

Preview Database 

You can see preview of database(s) whether MySQL is installed on your system or not.  

 

 To see preview of database(s) if MySQL is installed on your system, select database(s) 

automatically. 

 To see preview of database(s) if MySQL is not installed on your system, select database(s) 

manually. 

 To see preview of database(s) created in MySQL on Linux platform, copy database(s), ibdata file 

from Linux system and paste them in Windows operating system and then select database(s) 

manually. 

 

After scanning is completed successfully, the left pane displays list of database and its components in a 

tree like structure under the root Stellar Phoenix Database Repair for MySQL node.  

 

 

 

Expand the tree to view components of database(s). Select a component. The right pane shows all details 

of the selected component. 

 



 

 

To preview details of a specific item of the tree, use Search Tree Item option on the ribbon. To search for 

specific item, type name of the desired item in Find Items search text box and click Find button. Continue 

clicking Find button to find more items with the same text as entered in search text box. 

  



 

 

Repair Database 

After previewing database(s), you can start repair process. 

 

 

 

 Either a single component or entire database can be repaired. To repair a single component, 

uncheck all the other components by clearing corresponding check boxes. 

 To start repair process, click Repair button in File menu on the main user interface. Stellar 

Phoenix Database Repair for MySQL dialog box appears. Click Yes.   

 MySQL Repair dialog box appears, prompting for User Login Information of MySQL database. 

Provide the required information. Click OK.  

 Stellar Phoenix Database Repair for MySQL dialog box opens after successful repair of selected 

database(s). Click OK to close dialog box. 

 Selected database(s) or component is repaired and saved in a newly created folder at the location 

where MySQL is installed. This folder is named after the name of repaired database prefixed with 

the word repaired. For example, if name of the database is student then name of the folder will be 

repaired _student.  

  



Repair Database from a Linux System 

Stellar Phoenix Database Repair for MySQL gives option to recover data from database created in 

MySQL on a Linux based system. 

To recover data from database created in MySQL on a Linux based system: 

1. In Linux, copy the database folders and ibdata1 from \var\lib\MySQL. 

2. Paste copied database folders and ibdata1 in any drive of Windows based system.  

3. Launch Stellar Phoenix Database Repair for MySQL and select this database manually. 

4. Follow the procedure of recovery. 

5. In Windows, copy the recovered database folders and ibdata1 folder from C:\Program 

Files\MySQL\MySQL Server 6.0\data. 

6. In Linux, paste recovered database folders and ibdata1 at source location - \var\lib\MySQL.  

  



 

 

Customize the Software 

You can customize Stellar Phoenix Database Repair for MySQL as per your personal requirement and 

taste.  

 

To customize the software: 
 
You can add commands to Quick Access Toolbar 

You can assign desired keyboard shortcut to commands 

You can change the appearance of GUI 

 

To add commands to Quick Access Toolbar: 

1. Click button on Quick Access Toolbar on the main user interface. 

2. Click Select Database option to add this command to Quick Access Toolbar. 

3. Click Repair option to add this command to Quick Access Toolbar. 

4. Click More Commands option to open Customize window as shown here: 

 

 

 



 Select command(s) to be added to Quick Access Toolbar in left pane of Customize window 

and click Add button. The added command(s) will be listed on the right of Customize 

window.  

 If you wish to remove command(s) from Quick Access Toolbar, select command(s) on the 

right of the Customize window and click Remove button. 

 Click Reset button if you wish to undo all the changes. 

To assign desired keyboard shortcut to commands 

 Click Customize... button next to Keyboard shortcuts in Customize window 

 Customize Keyboard window opens as shown below: 

 

 

 

 Select command you wish to assign shortcut keys to and click in text box under Press new 

shortcut key. Press desired key(s).  

 Click Assign. 

 The key(s) you have pressed would be assigned to the selected command and listed in Current 

Keys box. 



 

 

 Assign as many keys as you wish to and after you are finished, click Close button to close 

Customize Keyboard window. 

To change the appearance of GUI 

 Click Show Below the Ribbon option to put Quick Access Toolbar below the menu ribbon. 

 Click Minimize the Ribbon option to minimize the menu ribbon. 

  



Save Log File 

Message Log Pane displays shows details of an ongoing process. After scanning process, this pane shows 

information such as, starting time of scanning process, database(s) name, components information and 

end time of scanning process. 

 

After repairing process, this pane shows information such as, start time of repair process, selected 

database(s) name, selected components or database(s), total number of records processed, total number 

of records recovered successfully and message showing successful completion of the process and end 

time of the repairing process. 

 

You can save as well as clear information displayed in Message log pane.  

To save log details in a text file: 

1. Click Save Log button in Tools menu on main user interface. 

2. The Save As dialog box opens.  

3. Type file name in File name text box and select desired location to save log file.  

4. Click Save.  

To clear the information displayed in the Message log pane: 

Click Clear Log button in Tools menu on main user interface. 

  



 

 

FAQs 

1. What does the demo version of the software do? 

Demo version of the software shows only preview of the database. To save repaired database, 

you need to purchase and activate the software. 

2. Does the recovery software make changes to my original file? 

No. The software saves repaired data in a new separate target folder. The software only reads 

the corrupt file. 

3. How to know whether the software will be able to recover my database or not? 

To know whether the software will be able to recover your corrupt MySQL database or not, 

please try demo version of the software. Scan your file using Stellar Phoenix Database Repair 

for MySQL and preview results for your satisfaction. 

4. Can Stellar Phoenix Database Repair for MySQL recover my deleted MySQL database? 

No. 

5. How much time Stellar Phoenix Database Repair for MySQL will take to scan and repair 

corrupt/damaged database? 

The time taken in scanning and recovering database is very dependent upon the size of database 

file. 

6. Is MySQL needed to be installed on the system for previewing database?   

No. 

7. Is MySQL needed to be installed on the system for recovering database? 

Yes, MySQL must be installed on the system to recover data from corrupt/damaged MySQL 

database.  

8. Is it possible to know total number of records recovered after a repair process? 

Yes. To know how many records have been recovered and other such details, please view 

message log in the bottom pane of application user interface. 

9. Can I recover database created on a Linux based system? 

Yes. You can recover your corrupt/damaged MySQL database even if it has been created on a 

Linux based system. To know how to recover your corrupt/damaged MySQL database created on 



a Linux based system, please refer Repair Database from a Linux System topic of this help 

manual. 

10. What can I do to customize the software? 

To customize the software, you can add commands to Quick Access Toolbar, assign desired 

keyboard shortcut to commands, and change the appearance of GUI. To know how to customize 

Stellar Phoenix Database Repair for MySQL, please view this topic of the help manual. 

  



 

 

Legal Notices 

Copyright 

Stellar Phoenix Database Repair for MySQL software, accompanied user manual and documentation are 

copyright of Stellar Information Technology Private Limited, with all rights reserved. Under the copyright 

laws, this user manual cannot be reproduced in any form without the prior written permission of Stellar 

Information Technology Private Limited No Patent Liability is assumed, however, with respect to the use of 

the information contained herein. 

 

Copyright © Stellar Information Technology Private Limited. INDIA. 

Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 

to change without notice. 

 

STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED PROVIDES NO WARRANTY WITH 

REGARD TO THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY 

EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR 

ANY PARTICULAR PURPOSE WITH REGARD TO ANY OF THE FOREGOING STELLAR 

INFORMATION TECHNOLOGY PRIVATE LIMITED ASSUMES NO LIABILITY FOR ANY DAMAGES 

INCURRED DIRECTLY OR INDIRECTLY FROM ANY TECHNICAL OR TYPOGRAPHICAL ERRORS OR 

OMISSIONS CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN THE PRODUCT AND THE 

MANUAL. IN NO EVENT SHALL STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED., BE 

LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL SPECIAL, OR EXEMPLARY DAMAGES, 

WHETHER BASED ON TORT, CONTRACT OR OTHERWISE, ARISING OUT OF OR IN CONNECTION 

WITH THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN OR THE USE THEREOF. 

Trademarks 

Stellar Phoenix Database Repair for MySQL® is a registered trademark of Stellar Information 

Technology Private Limited. 

Windows 2003 Server®, Windows 2008 Server®, Windows XP®, Windows Vista®, Windows 7®, 

Windows 8® and Windows 10® are registered trademarks of Microsoft® Corporation Inc. 

The name MySQL is trademarked and may only be used with the trademark holder's permission. 

http://www.mysql.com/company/legal/trademark.html 

All Trademarks Acknowledged. 



All other brands and product names are trademarks or registered trademarks of their respective 

companies. 

License Agreement 

Stellar Phoenix Database Repair for MySQL 

Copyright © Stellar Information Technology Private Limited. INDIA 

www.stellarinfo.com 

All rights reserved. 

All product names mentioned herein are the trademarks of their respective owners. 

This license applies to the standard-licensed version of Stellar Phoenix Database Repair for MySQL. 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing or distributing this 

software, unless you have a different license agreement signed by Stellar Information Technology Private 

Limited. 

If you do not agree to all of the terms and conditions of this License then do not copy, install, distribute or 

use any copy of Stellar Phoenix Database Repair for MySQL with which this License is included, you 

may return the complete package unused without requesting an activation key within 30 days after purchase 

for a full refund of your payment. 

The terms and conditions of this License describe the permitted use and users of each Licensed Copy of 

Stellar Phoenix Database Repair for MySQL. For purposes of this License, if you have a valid single-

user license, you have the right to use a single Licensed Copy of Stellar Phoenix Database Repair for 

MySQL. If you or your organization has a valid multi-user license, then you or your organization has the 

right to use up to a number of Licensed Copies of Stellar Phoenix Database Repair for MySQL equal to 

the number of copies indicated in the documents issued by Stellar when granting the license. 

Scope of License 

Each Licensed Copy of Stellar Phoenix Database Repair for MySQL may either be used by a single 

person or used non-simultaneously by multiple people who use the software personally installed on a single 

workstation. This is not a concurrent use license. 

All rights of any kind in Stellar Phoenix Database Repair for MySQL, which are not expressly granted in 

this license, are entirely and exclusively reserved to and by Stellar Information Technology Private Limited. 

You shall not rent, lease, modify, translate, reverse engineer, decompile, disassemble or create derivative 

works based on Stellar Phoenix Database Repair for MySQL nor permit anyone else to do so. You shall 

http://www.stellarinfo.com/


 

 

not make access to Stellar Phoenix Database Repair for MySQL available to others in connection with a 

service bureau, application service provider or similar business nor permit anyone else to do so. 

Warranty Disclaimers and Liability Limitations 

Stellar Phoenix Database Repair for MySQL and all accompanying software, files, data and materials 

are distributed and provided AS IS and with no warranties of any kind, whether expressed or implied. You 

acknowledge that good data processing procedure dictates that any program including Stellar Phoenix 

Database Repair for MySQL must be thoroughly tested with non-critical data before there is any reliance 

on it and you hereby assume the entire risk of all use of the copies of Stellar Phoenix Database Repair 

for MySQL covered by this License. This disclaimer of warranty constitutes an essential part of this License. 

In addition, in no event does Stellar authorize you or anyone else to use Stellar Phoenix Database Repair 

for MySQL in applications or systems where its failure to perform can reasonably be expected to result in 

a significant physical injury or in loss of life. Any such use is entirely at your own risk and you would not 

hold Stellar responsible for any and all claims or losses relating to such unauthorized use. 

In no event shall Stellar Information Technology Private Limited or its suppliers be liable for any special, 

incidental, indirect, or consequential damages whatsoever (including, without limitation, damages for loss 

of business profits, business interruption, loss of business information, or any other pecuniary loss) arising 

out of the use of or inability to use the software product or the provision of or failure to provide support 

services, even if Stellar Information Technology Private Limited has been advised of the possibility of such 

damages. In any case, Stellar Information Technology Private Limited’s entire liability under any provision 

shall be limited to the amount actually paid by you for the software product. 

General 

This License is the complete statement of the agreement between the parties on the subject matter and 

merges and supersedes all other or prior understandings, purchase orders, agreements and arrangements. 

This License shall be governed by the laws of the State of Delhi, India. Exclusive jurisdiction and venue for 

all matters relating to this License shall be in courts and fora located in the State of Delhi, India and you 

consent to such jurisdiction and venue. There are no third party beneficiaries of any promises, obligations 

or representations made by Stellar herein. Any waiver by Stellar of any violation of this License by you shall 

not constitute nor contribute to a waiver by Stellar of any other or future violation of the same provision or 

any other provision of this License. 
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About Stellar 

Stellar Information Technology Private Limited is a trusted name in the field of Data Repair and Data 

Protection Software for more than a decade. 

 

We provide the widest range of Data Repair Products. Our range includes Data Repair Software for almost 

all Operating Systems and File Systems. 

Product line: 

Data Repair 

A widest range of data recovery software that helps you recover your valued data lost after accidental 

format, virus problems, software malfunction, file/directory deletion, or even sabotage!. More Info >> 

File Repair 

The most comprehensive range of file undelete and unerase software for Windows and MS office repair 

tools. More Info >> 

E-mail Repair 

A wide range of mail recovery, mail repair and mail conversion applications for MS Outlook, MS Outlook 

Express and MS Exchange useful in instances of data loss due to damages and corruption of E-mail.  

More Info >> 

Data Protection 

A wide range of Prevent Data Loss, Data backup and Hard Drive Monitoring Applications to ensure 

complete data protection against hard drive crash. More Info >> 

Data Sanitization 

Data cleanup and file eraser utility can delete selected folders, groups of files, entire logical drives, System 

Traces & Internet traces. Once the data have been removed using Stellar Wipe - Data File eraser utility, it 

is beyond recovery limits of any Data Repair Software or utility. More Info >> 

Data Erasure 

Stellar Data Erasure software under the brand BitRaser help businesses & consumers permanently erase 

confidential data beyond the scope of data recovery.  You can perform high-speed bulk data erasure & 

http://www.stellarinfo.com/disk-recovery.htm
http://www.stellarinfo.com/undelete.htm
http://www.stellarinfo.com/mail-recovery.htm
http://www.stellarinfo.com/prevent-dataloss.htm
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generate erasure certificates for audit trail purpose. BitRaser supports 24 International data erasure 

standards. More Info >> 

 

For more information about us, please visit www.stellarinfo.com 
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